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MOLECULAR MODELLING EXERCISES  
OPIOIDS 
 
Exercise 24.17    Delta-selective agonists 
 
INTRODUCTION 
 
TAN-67 (Fig. 1) is a full and potent agonist with a high level of delta selectivity.  The pyridine 
nitrogen serves as a hydrogen bond acceptor with the binding site, and plays an important 
role in TAN-67 acting as a selective agonist rather than an antagonist. The phenol ring is 
freely rotatable, which is also important for agonist activity. Evidence for this comes from 
structure XV (a weak antagonist), which has the phenol ring locked in a particular 
conformation. Replacing the pyridine ring with a pyrazine ring (Structure XVI) resulted in a 
drop in both activity and selectivity, and this was attributed to the crucial nitrogen (coloured 
pink) being weakened as a hydrogen bond acceptor. In this exercise, we will compare 
structures XV and XVI with TAN-67. 
 
 
 

 
 
 
 
 
 
 
Figure 1 Structures of TAN-67, structure XV and structure XVI. 
 
INSTRUCTIONS 
It is suggested that you attempt the following instructions yourself before following the more 
detailed Procedures that follow. You may find the file entitled Common Operations for 
ChemBio3D/Chem3D a useful guide on how to carry out various operations.  
 
PART A 
*Create the energy-minimised 3D-structures of TAN-67 and Structure XV from their 
ChemDraw files (available in the ChemDraw folder) ensuring that the piperidine rng is in the 
chair conformation. 
*Overlay TAN-67 with Structure XV by matching up the nitrogen atoms in the message and 
address moieties. 
*With the aid of the overlay, modify the structure of TAN-67 to propose an active 
conformation for agonist activity. 
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*With the aid of the overlay, modify the structure of TAN-67 to propose a conformation that 
might result in antagonist activity. 
*Quantify the difference between the two conformations. 
*Calculate the steric energies for both conformations. 
*Identify the more likely conformation. 
PART B 
*Copy and paste the proposed active conformation for TAN-67 into a new window and 
modify it to create an energy-minimised 3D-model of Structure XVI. 
*Overlay Structure XVI with the proposed active conformation of TAN-67. 
*Calculate the partial charges for both structures and identify the partial charge on the 
nitrogen within the address moiety. 
*Build energy-minimised bicyclic systems representing the address moieties in TAN_67 and 
Structure XVI. 
*Calculate Lowdin and Mulliken charges using GAMESS software and identify the partial 
charge on the nitrogen within the address moiety. 
*Calculate the electrostatic potential maps for the two structures. 
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PROCEDURES 

There are various approaches that you can use to tackle these molecular modelling exercises. 
The following procedures illustrate how you might tackle this particular exercise, but they are 
not meant to be prescriptive. Note also that the results obtained may vary depending on the 
computer and the version of ChemBio3D or Chem3D used. For example, the specific 
conformations obtained from energy minimisation may differ, as may quantitative results 
such as steric energies. 
 
 
Part A) Comparison of Structure XV with TAN-67 
 
1. Create the energy-minimised 3D-model of TAN-67 
*Open ChemBio3D or Chem3D. 
*From the File menu, choose Open, then select the ChemDraw file for TAN-67 from the 
ChemDraw folder.  
*Click Open. 

*Carry out an energy minimization process  to produce a structure (Fig. 2) with a steric 
energy of 23.17 kcal/mol. 
*Describe the shape of the molecule. 
The molecule has a distorted T-shape where the rings of the tetracyclic system form the 
crossbar. The phenol ring is the stalk of the T-shape and hangs below the tetracyclic ring system  

  
Figure 2  Energy-minimised structure of TAN-67. 
 
 
 2. Create the energy-minimised 3D-model of Structure XV 
 
*Follow the same procedure as above to produce the 3D model of structure XV, which is 
available in the ChemDraw folder as the ChemDraw file Structure XV.cdx. The energy-
minimised structure (Fig. 3) has a steric energy of 48.16 kcal/mol. Note that the piperidine ring 
is in a twist-boat conformation.  
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Figure 3  Energy-minimised structure of Structure XV in two different display modes. 
 
 
3. Modify structure XV such that the twist boat is altered to a chair conformation. 
 

*Choose the select tool . 
*Click on the nitrogen atom within the twist boat to select it.  
*From the Structure menu, select Invert.  

*Carry out another energy minimization . This successfully produces a chair conformation 
with a steric energy of 39.23 kcal/mol (Fig. 4). 
 

 
Figure 4  Energy-minimized structure of Structure XV with a chair conformation. 
 
 
4. Recolour TAN-67 and align it with structure XV 
*From the File menu, choose New to produce a new window. 
*Copy and paste Tan-67 and structure XV into the new window. 
*Align TAN-67 with structure XV in the new window such that they have similar orientations. 
*Recolour structure XV. 
*Pair up the nitrogen atoms in the two structures as indicated in figure 5. 
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Figure 5  Alignment and pairings of Tan-67 (green) and structure XV prior to overlay. 
 
5. Overlay Tan-67 with structure XV 
*From the Structure menu, choose Overlay, then click on Minimise.  
*A dialogue box will appear. Retain the default values and click Start. 
 
 

 
Figure 6  Overlay of Tan-67 (green) and structure XV.  
 
 
In the trial run, the initial overlay was not particularly good and the structures had to be 
manually manipulated to bring the paired atoms closer. Another overlay was then carried out 
which brought the paired atoms within 0.1 Å of each other. The nitrogen atoms are now well 
superimposed, and there is a reasonable alignment of the tetracyclic ring systems (Fig. 6). The 
phenol rings are in the same region of space, but are orientated differently. Indeed, the phenol 
OH groups are orientated in opposite directions. Since the phenol group is an important part 
of the opioid pharmacophore, this implies that one of the structures must be in the wrong 
conformation. The phenol ring in structure XV is locked in the one position, whereas the 
phenol ring in TAN-67 is freely rotatable. This means that the conformation used for TAN-67 
cannot be the active conformation, and that the aromatic ring should be rotated 180o such 
that the phenol group is pointing in a similar direction to the phenol group for structure XV. 
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6. Measure a dihedral angle that defines the orientation of the phenol ring in TAN-67.  
*Choose the Select tool. 
*Click on the three bonds that are coloured yellow in figure 7 to highlight them. 
*From the Structure menu, choose Measurements, then choose Display Dihedral 
Measurement. 
The dihedral angle is defined as 61.2o (Fig. 7). 
 

 
Figure 7  Dihedral angle measurement used to define the phenol ring orientation in TAN-67. 
 
7. Rotate the phenol ring in TAN-67 by 180o. 

*Choose the Select tool . 
*Click on the rotatable bond to the phenol ring of TAN-67 to highlight it (Fig. 8A). 
*Open the Rotation Dial and select the SW pointing arrow at the bottom right (Fig. 8B). 
*Enter 180o into the type box and press return on the keypad. 
The resulting conformation (Fig. 9) is a more likely active conformation for TAN-67. 
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Figure 8  A) Highlighting the bond to be rotated. B) The Rotation Dial.  
 

 
Figure 9  Conformation of TAN-67 following 180o rotation of the phenol ring.  
 
 
8. Rotate the phenol ring of TAN-67 to bring it parallel to the phenol group of Structure 
XV. 
We will now rotate the phenol ring of TAN-67 such that it is parallel to the phenol ring of 
Structure XV.  
 
*Ensure that the rotatable bond is still highlighted. 
*Orientate the overlay such that you are looking side on to the phenol ring of structure XV 
(Fig. 10A). 
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*Use the rotation dial to rotate the phenol ring of TAN-67 until it is as parallel as it can be 
with the phenol ring of structure XV (Fig. 10B). In the trial run, this involved rotating the 
bond by -40o. However, this value can differ depending on the type of overlay obtained. 
 
  

  
   A      B 
Figure 10 A) Overlay before rotation. B) Overlay after rotation.  
 
Figures 10B & 11 show that the phenol rings are parallel and mostly overlapping. The phenol 
groups are also sufficiently close that they could form a hydrogen bond to the same region of 
the binding site.  
 
 

  
  
 
Figure 11  Modified overlay to show improved matching of phenol rings (different 
perspectives). 
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Figure 12 also demonstrates that the two phenol rings are parallel to each other in similar 
regions of space. This perspective also shows that the tetracyclic ring systems lie directly on 
top of each other, although figure 11A shows that they are angled differently. 
 

 
 
Figure 12  Modified overlay showing the tetracyclic rings lying over each other. 
 
Structure XV is a weak antagonist and TAN-67 is a potent agonist. This suggests that the 
orientation of the phenol ring in structure XV is correct for antagonist activity, whereas the 
phenol ring in TAN-67 can rotate to find an orientation that allows the drug to act as an 
agonist.  If the conformation of TAN-67 in figure 9 is the active conformation required for 
agonist activity, then the analysis carried out above implies that a rotation of 40o can make 
the difference between agonist and antagonist activity.  
 
 
9. Identify the steric energy of the proposed active conformations for TAN-67  
In the previous section, we rotated the phenol ring 180o to create a proposed active 
conformation for agonist activity, then rotated it -40o to create a conformation that matched 
structure XV. How stable are these conformations and how likely are they? In this section, we 
will modify the original energy-minimised structure of TAN-67 to create the proposed active 
conformation and measure its steric energy.  
*Go to the window containing the original energy-minimised structure of TAN-67. 
*Copy and paste the structure into a new window (Fig. 13A). 

*Rotate the phenol ring 180o and energy minimize  the structure. The modified structure 
remained in the same conformation and energy minimized to a conformation with a steric 
energy of 23.37 kcal/mol (Fig. 13B). This compares to a steric energy of 23.2 for the original 
conformation. The conformations have very similar steric energies.  Therefore, both 
conformations are equally likely and the proposed active conformation for TAN-67 (Fig. 13B) 
is a low-energy, stable conformation. 
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    A     B 
Figure 13 A) Original energy-minimised structure of  TAN-67 B) Energy-minimised structure 
of TAN-67 after rotation of the phenol ring by 180o.   
 
10. Calculate the steric energy of the conformation of TAN-67 that matches structure 
XV  
*Repeat section 9 above but do not energy minimize the modified structure (Fig. 14). 
 

 
Figure 14  TAN-67 after rotation of the phenol ring by 180o (unminimised). 
 
*Use the select tool to select the bond highlighted in figure 15. 
*Open the rotation tool and enter -40o into the type box (Fig. 15). 
*Press return on the keypad to rotate the bond (Fig. 16).  
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Figure 15 TAN-67 before further rotation of phenol ring by -40o. 

 
Figure 16 TAN-67 after further rotation of the phenol ring by -40o. This conformation of 
TAN-67 matches structure XV in terms of the phenol ring orientation. 
 
*From the Calculations menu, choose MM2, then Compute Properties.  
*Select Pi Bond Orders and Steric Energy Summary, and click Run. The value appears in 
the bottom window as 36.6 kcal/mol (as compared to 23.2 kcal/mol for the energy-
minimised structure).  
This is significantly higher than the proposed active conformation for agonist activity shown 
in figure 13B. Therefore, the structure is more likely to be in the proposed active 
conformation for agonist activity than the conformation likely to result in antagonist activity. 
 
11. Carry out a conformational analysis of the conformations generated by rotation 
about the C-Ar bond for TAN-67. 
A plot can be created that measures the steric energies of conformations resulting from 
rotation round a single bond. We will do that for TAN-67 to see whether there are any serious 
energy barriers that would prevent free rotation of the phenol ring. The analysis will be 
carried out such that a conformation is generated every time the bond is rotated 1o. 
The conformation used to generate the plot is the one where the aromatic ring has been 
rotated 180, then -40 degrees (Fig. 16). 
*From the File menu, choose Preferences to open up a dialogue box. 
*Click on the tab for Dihedral Driver to open another dialogue box. 
*Use the Slider Bar that is present to set the Resolution to 1o, then click on OK. 
*Choose the Select tool and click on the rotatable bond to highlight it. 
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*From the Calculations menu, choose Dihedral Driver, then Single Angle Plot. The bond 
will now rotate as the conformations are generated. A plot should appear above the main 
window (Fig. 17). If not, open the chart from the View menu. Failing that, drag down the top 
margin of the main window.  
 

 
Figure 17 Dihedral Driver Chart at 1o resolution. 
 
The dihedral angle used to define the conformation is C(3)-C(4)-C(11)-C(12), which 
corresponds to the atoms highlighted in figure 18A. The relevant dihedral angle for the initial 
structure is  -97.7o (Fig. 18B). The corresponding point on the chart for this conformation is 
shown in figure 19. The steric energy corresponds with what was calculated before. This is 
close to a slight energy minimum on the chart, but the fact that TAN-67 is an agonist suggests 
that it prefers the more stable conformations shown on the plot. 
 
 
 
 

  
  A      B 
 
Figure 18  A) Definition of dihedral angle C(3)-C(4)-C(11)-C(12). B) Dihedral angle of the 
initial conformation.  
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Figure 19  Position of conformation (Fig 18B) on the dihedral driver chart. 
 
The relevant dihedral angle for the proposed active conformation of TAN-67 (unminimised) 
(Fig. 14) was measured as C(3)-C(4)-C(11)-C(12)  = -57.7o (Fig 20). This conformation 
corresponds to an energy minimum on the chart (Fig. 21) 
 

  
 
Figure 20  Proposed active conformation for TAN-67 as an agonist. 
 

 
Figure 21 Proposed active conformation for TAN-67 and its position in the chart. 
 
The active conformation is shown in figure 22A from a slightly different perspective, 
alongside the other stable conformation where the phenol ring has rotated 180o (Fig. 22B). 
 

 
  A      B 
Figure 22  A) Proposed active conformation for agonist activity. B) Conformation with phenol 
group pointing the wrong way. 
 
The other energy minimum in the plot corresponds to the initial energy-minimised structure 
of TAN-67 where the phenol group is pointing the wrong way (Figs. 22B and 23) 
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Figure 23  Position on the plot for the initial energy-minimised conformation of TAN-67 with 
the phenol OH group pointing the wrong way. 
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PART B) Comparison of Structure XVI and TAN-67 
The results of part A indicate that the phenol ring of the original energy-minimised structure 
of TAN-67 has to be rotated 180o to form a more likely active conformation. Therefore, this is 
the conformation we will use to create structure XVI. 
 
1. Copy and paste the proposed active conformation of TAN-67 into a new window 
*Go to the window containing the proposed active conformation of TAN-67. 
*Copy and paste the structure into a new window (Fig. 24A). 
 

   
  A       B 
 
Figure 24  A) Proposed active conformation for TAN-67 B) Energy-minimised Structure XVI. 
 
2. Modify TAN-67 to form structure XVI 
 
*Choose the Text tool .   
*Click on the carbon atom on the opposite side of the pyridine ring from nitrogen to open a 
text box. 
*Type N into the text box and press return on the keyboard.  

*Carry out an energy minimisation  to give Structure XVI (Fig. 24B). 
The steric energy is 25.96 kcal/mol.  
 
3. Align TAN-67 with structure XVI 
*Recolour TAN-67 
*Copy and paste TAN-67 and Structure XVI into a new window. 
*Align the molecules such that they are similarly orientated. 
*Pair up the nitrogen atoms as shown in figure 25. 
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Figure 25   Pairing up atoms for TAN-67 (green) and Structure XVI. 
 
4. Overlay TAN-67 with Structure XVI. 
*Overlay the structures as previously described. 
Three successive overlays were carried out at a minimum RMS error of 0.100, resulting in a 
separation between the paired nitrogen atoms of 0-0.2 Å. A slight manual rotation and 
another minimisation resulted in an improved overlay (0-0.1 Å) (Fig. 26). 
There is a good superposition for all the features. 
 

 
Figure 26   Overlay of TAN-67 with Structure XVI 
 
5. Measure the dihedral angles of the structures used for the overlay. 
The structures overlay almost perfectly and the dihedral angles shown in figure 27 are very 
similar (61.0o and 60.8 o) as one might expect (Fig. 27). However, the activity of structure XVI 
is weaker than for TAN-67. This was put down to the nitrogen being a weaker HBA, in which 
case it should be less electron rich. We will now look at the partial charges for these 
molecules. 
 



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

 

  
Figure 27   Dihedral angles measured for A) TAN-67 and B) Structure XVI. 
 
 
6. Identify the partial charges on the nitrogen atom that is thought to act as a HBA for 
TAN-67 
 
*From the Calculations menu, choose Extended Huckel, then Calculate Charges. An atom 
property window appears to show the results. It can also be accessed from the View menu by 
choosing Atom Property Table. 
*Identify the partial charge for the nitrogen atom in the piperidine ring. 
The atom is defined as N Pyridine on the Atom Properties Table and is shown as having a 
partial charge of -0.265582. 
It is also possible to display partial colours by colour on the model, with red corresponding to 
positive charge and blue corresponding to negative charge.  
*From the File menu, choose Model Settings, then select the Colors and Font tab.  
*Under Color by, choose Atom Properties, then select Charge (Huckel). 
*Select a colour band.  
*In the min/max text boxes, select the range of calculations to be coloured. For the full range, 
click Scan Value Range.  
*Select the Preview check box at the bottom of the dialogue box and click Apply.  
*Finally click OK. The coloured structure is shown in figure 28A. 
 

  
   A      B 
Figure 28 A) Tan-67 coloured by partial charge. B) Structure XVI coloured by partial charge 
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7. Identify the partial charges on the nitrogen atom that is thought to act as a HBA for 
Structure XVI. 
*Carry out the same procedures described above to identify the partial charge for the 
equivalent nitrogen atom in structure XVI. The corresponding atom is shown as having a 
partial charge of -0.24112. This indicates that the nitrogen in structure XVI is less electron 
rich than the nitrogen in TAN-67. 
*Display the structure by partial charge. The resulting structure is shown in figure 28B. There 
is not an obvious difference in colour for the relevant nitrogen atoms. 
 
8. Create Electrostatic Potential Maps for relevant bicyclic ring systems  
GAMESS calculations can be used to calculate charges and electrostatic potential maps. 
However, the calculations would take a long time for the full structures of TAN-67 and 
Structure XVI. Therefore, we will consider only the relevant bicyclic rings shown in figure 29. 
 

   
  A       B 
Figure 29  Bicyclic ring systems A) corresponding to TAN-67 and B)  corresponding to 
Structure XVI. 
 
*Build the bicyclic ring system corresponding to TAN-67 as shown in figure 29A. 

*Energy minimise the structure . Energy minimisation gives structure A with a steric 
energy of 3.83 kcal/mol. 
*From the Calculations menu, choose GAMESS Interface, then Compute Properties.  
*Click the tick box for All.   
*Click Run.  A black curly arrow rotates in the top menu bar to indicate the calculation is in 
progress. The calculation will take about 5-10 minutes. 
*Once the calculation is completed, further calculations are added to the Atom Properties 
Window, which includes partial charges defined as Lowdin charges and Mulliken charges. The 
charges for the pyridine nitrogen are the following; 
Lowdin charges: -0.165968 
Mulliken charges:-0.866392 
*Calculate the electrostatic potential map from the Surfaces menu and display in wire mesh 
(Fig. 30). The calculation takes a few minutes. 
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Figure 30 Electrostatic Potential Map for Ring A 
 
*Carry out the same procedures for the bicyclic ring system corresponding to structure XVI 
(Fig. 29B). 
Structure B was built and energy minimised with a steric energy of 6.2 kcal/ mol. The charges 
calculated by GAMESS were as follows: 
Lowdin charges: -0.124 or -0.127  (compared to -0.165968 for TAN-67) 
Mulliken charges:-0.783 or -0.772  (compared to -0.866392 for TAN-67) 
 
These are significant differences indicating that the presence of the additional nitrogen in 
structure XVI weakens the electron density on the nitrogen that acts as an HBA.  
 
The electrostatic potential map for the bicyclic ring system corresponding to Structure XVI is 
shown in figure 31. The blue region for the nitrogen acting as an HBA is slightly smaller 
compared to the corresponding region in figure 30. 
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Figure 31 Electostatic Potential Map for the bicyclic ring corresponding to Structure XVI. 
 
 


